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INTRODUCTION

This manual contains the basic guidelines for 
proper use of the SaniBID sewerage design soft-
ware. SaniBID is integrated with QGIS, which, as 
an open and free software, is an excellent tool for 
disseminating knowledge to professionals and 
students interested in condominial sanitation. Its 
simplicity allows users to quickly draw collector 
lines and edit layouts, perform design calcula-
tions in project conception and design, and cre-
ate simulations and look at alternatives to opti-
mize the project. In addition, as a free software, 
improvements and new features can be added by 
the user community. It allows a designer to create 
not only the collector system plans as a product, 
but also the developed model itself, giving the 
service provider, or anyone who gets the model, 
the ability to make adjustments in the project, all 
integrated in a Geographic Information System 
(GIS).

Compliance with the United Nations SDGs on 
sanitation is a huge challenge in all areas, both 
rural and urban, but it is especially difficult in the 
periurban areas of large cities and towns. Even 
with a substantial increase in sanitation invest-
ment, a solution to the problem will not be possi-
ble without a paradigm shift, which must include 
making better use of available technologies and 
the increasing inclusion of creative professio- 
nals and innovative technologies in a traditionally 
“conservative” field such as that of sanitary engi-
neering.

A notable exception to the conservatism which 
has prevailed in the sanitation sector for over one 
hundred years was the emergence of the Condo-
minial system in the early 1980s in Brazil. Its lower 
investment costs and ability to adapt to complex 
urban landscapes, as well as the fact that it uses a 
social intervention model which is very effective 
in cultivating user buy-in, make it the ideal solu-
tion to meet the sanitation challenges presen- 
ted in peripheral areas. Between the 1990s and 
the beginning of the 21st century the Baia Azul 
project in the Brazilian city of Salvador da Bahia 
brought sanitation to hundreds of thousands of 
people and demonstrated the enormous positive 

impact that wastewater removal can have on 
public health in densely populated informal se- 
ttlements. In the same period, CAESB’s syste- 
matic adoption of condominial sanitation in 
Brasilia confirmed that use of the technology is 
equally valid for the formal and informal areas of 
a city. The system has also ventured outside Bra-
zil, with projects such as the sanitation programs 
in Lima (Peru) and La Paz (Bolivia).

In light of these experiences, Condominial Se- 
werage, combined with improved faecal sludge 
management and on-site containment systems, 
is considered a viable alternative to conventional 
sewage for meeting the SDG sanitation targets 
in middle and low-income countries. The tremen-
dous effort which has been made to improve 
knowledge about on-site containment systems, 
however, contrasts greatly with the limited atten-
tion given to Condominial Sewerage systems in 
recent years. It is paradoxical that in many cases 
Condominial Sewerage is considered to be the 
only viable solution for providing piped water 
and sanitation of densely occupied slums, but in 
practice the technology remains, by most profe- 
ssionals in the sector, a little understood alterna-
tive.

The Condominial system is often confused with 
simplified sewage and variations of low-cost and/
or limited engineering sanitation systems which 
do not include community involvement, a key 
element in the success of the Condominial alter-
native. Pipe diameters are often presented as a 
problem, although it is common knowledge that 
minimum diameters vary and the operational per-
formance of a sewage collection system is affect-
ed not only by pipe diameters but by a host of 
factors including: the quality of the project; of the 
work; of operation and maintenance; as well as 
how the user utilizes the system; and local condi-
tions, including the existence of complementary 
infrastructure and services, such as garbage co- 
llection. Many professionals still see Condomini-
al Sewerage as a solution for the poor, a system 
which does not provide the user with the same 
quality of service that conventional technology 
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offers, although the example of CAESB in Brasilia 
shows that it is a solution that can be used city-
wide, regardless of the income status of the user.

To address the lack of knowledge about the Con-
dominial system, it is fundamental to have dy-
namic tools which can inform professionals inte- 
rested in the subject. To this end, in 2012 a se-
ries of practical project workshops were created 
for professionals from different institutions in the 
sector. These workshops have been held in se- 
veral countries in Latin American and the Cari- 
bbean. They have been an excellent training tool, 
but their impact has been limited by the num-
ber of participants able to attend. In an effort to 
broaden the scope of these training sessions, the 
idea of using a platform such as QGIS arose, to 
create a modern, free and efficient tool that fa-
cilitates interactions between students, teachers 
and experienced professionals in the creation of 
concrete Condominial projects. Prior to the re-
lease of this first edition, SaniBID was success-
fully tested in classes as well as on real projects 
in the cities of Cap Haitien1 (Haiti) and Santiago 
de los Caballeros (Dominican Republic) and will 
be improved in future versions with contributions 
from the user community. 

1 Some of the Cap Haitien project data can be downloaded for aca-
demic purposes at https://github.com/leonazareth/sanibid_redbasica
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SPECIFICATIONS

SaniBID RedBasica2 is a free software that aims 
to assist in the design and sizing of sewage co- 
llection networks, with tools for designing Con-
dominial systems. It works as a plugin to the free 
and open source geographic information system, 
QGIS3.

In addition to the free module, this quick guide 
uses a hydraulic calculation and sizing spread-
sheet developed in Excel software, supplied with 
the plugin. Also, the user can use data exported 
by QGIS to calculate in another spreadsheet or 
software of their choice.

The software was originally developed for the 
Inter-American Development Bank (IDB), the 
Spanish Agency for International Development 
Cooperation (AECID) and the Latin America In-
vestment Facility - European Union (LAIF) for 
the purpose of education and to promote free 
access to modern tools for the design of sewage 
systems, with adapted functions for the design of 
Condominial sewerage systems. The first version 
was created for the currently outdated QGIS 2.x.
The current version of the software is sponsored 
by the IDB and was designed to fix some issues 
identified in the previous version, incorporate 
tools and enhancements for software performan-
ce and functionality, and update the plugin code 
for Python 3 and PyQt 5, which is the current 
standard accepted by QGIS. SaniBID RedBasica, 
beta version 0.9, is supported from QGIS 3.0 until 
3.4 and Excel version 2010 onwards with a 32 or 
64-bit Windows operating system.

2 SaniBID RedBasica is Copyleft software. It has a free source code for 
upgrades and enhancements. However, ensuring that products deri-
ved from the version available here are licensed under identical terms, 
and any type of commercialization is prohibited. License Terms: Crea-
tive Commons Attribution-NonCommercial-ShareAlike
3 Official QGIS Software Website https://qgis.org

SaniBID RedBasica uses specific features of both 
QGIS and Excel to provide powerful and practical 
tools for automated sewage layout and calcula-
tion:
 

•	 the ease of working with QGIS georeferen-
ced maps and drawings for layout design and 
project plans and; 

•	 the practicality of working with a familiar 
spreadsheet or prefered calculation software.

The link between QGIS modules and the method 
of calculation (spreadsheet or software) is based 
on SaniBID RedBasica’s comma-separated value 
(“.csv”) text file export and import functions.

The spreadsheet provided (RedBasica) is based 
on the Brazilian standard “Design of Sewage Co- 
llection Networks” (NBR 9649), including the cal-
culation of tractive tension. The calculation para-
meters, however, can be freely adjusted by the 
user to local characteristics.

https://qgis.org/es/site/
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1.
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This quick guide for using SaniBID RedBasica 
(QGIS add-on and Excel spreadsheet) is structu-
red in the form of a tutorial, illustrating the key 
steps in using the software for designing a Con-
dominial sewerage project in a hypothetical pro-
ject area.

The installation files, Excel-based spreadsheet, 
and sample base files used in this quick guide 
can be downloaded from https://github.com/leo-
nazareth/sanibid_redbasica, respectively:

•	 SaniBID_RedBasica-master.zip
•	 SaniBID_RedBasica_Dimensioning_Spread-

sheet_EN.xlsm
•	 Exemplos Guia Rapido.rar

    1.1 Plugin installation and display

Installation of the SaniBID RedBasica plugin on 
QGIS is done through Plugin Manager > Manage 
and Install Plugins option located on the left side 
of the window. With the option selected, indicate 
the location of the SaniBID_RedBasica-master.
zip file and click on Install Plugin.

    1.2 RedBasica Project and Layer 
	 Configuration

When a QGIS project file loads, you will see three 
base layers as examples. One raster layer, corre-
sponding to the digital terrain model, and two 
vector layers, corresponding to contour lines of 
the project area and the cartographic base of the 
planned project area (block and lot division).

To configure the vector layers of the basic net-
work and inspection devices (Inspection Boxes - 
IB or Manholes - MH) use the      button to select 
the New Layer option and enter a layer name for 
the segments. A vector layer of segments will be 
created in the Layers folder and automatically in-
serted into the project.

Once the plugin is installed, enable the tool display 
and the panel window through the menu View> 
Toolbar> SaniBID RedBasica and View> Panels> 
SaniBID RedBasica. With this the following tools 
and panel should be displayed.

2 Os arquivos de instalação e do exemplo citado 
podem ser baixados do link para download: 
https://github.com/leonazareth/sanibid_redbasica/

The layers and the project are configured 
for the Coordinate Reference System (CRS) 
EPSG: 32722 (WGS84 / UTM - 22S). For new 
projects, first configure the desired flat coor-
dinate system and then save the QGIS pro-
ject to a computer directory.
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    1.3 Setup for RedBasica Layout

Before beginning layout on the basic network, 
create a base for the area in question, including 
the block and plot plans and a topographic mo- 
del of terrain elevation and contours.

The first step is to define the project area (drain-
age basins), identify the blocks within the area, 
and count the plots of each block for flow calcu-
lations. For this the button is       used, which will 
create the vector layer blocks.

When the layer has been created, (1) select it 
(2) enable Layer Edit mode and (3) click on Add 
Point Feature, as shown below.

When the blocks have been identified and the 
lots have been counted, find and mark the points 
where water concentrates naturally on each block 
(low points, or block exits). These low points in-
dicate where the basic collector network should 
run to facilitate the easiest connection of each 
block’s Condominial extension to receive that 
block’s contribution of sewage. For this, the bu- 
tton creates the vector       layer pre1.

After the layer is created, select it and enable the 
layer edit mode and click on Add Feature (using 
the same steps used in the block layer). 
To insert the arrows:

•	 Left click on the desired location of the base 
of the arrow in the block;

•	 Left click on the low point (lowest elevation) 
of the block, using the contour lines;

•	 Right-click to insert the arrow.

The illustration below demonstrates the blocks 
with arrows marking their low points in the pro- 
ject area. In this example, it is assumed that all 
lots (contribution units) will be occupied at the 
end of the plan and that the initial situation co- 
rresponds to 60% of occupied lots.

To add a new feature, left-click inside the block 
and fill in the attributes.

•	 ID_QE - Block identification;
•	 QE_IP - number of standard contribution 

units at plan start;
•	 QE_FP - number of standard contribution 

units at plan end.

The vector layers used for project assistance 
(blocks, pre1 and pre2) cannot be renamed 
by the user.

The QC1 feature represents a concentrated se- 
wage flow equivalent to 2300 standard contribu-
tion units, representing the discharge of waste-
water from the orange bounded area of the map. 
This flow will be released into the basic collector 
network at the location indicated by the arrow.
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    1.4 Layout of Basic Network and 
	 Inspection Devices

With an equal number of lots for the start and 
end of plan and the location of the sewage con-
tribution location of each block (Q01, Q02, Q03 
...) or concentrated flow (QC1) identified and 
marked, the layout of the basic sewage network 
can begin. 

The basic collection network should run tangen-
tially to the blocks, preferably passing through 
the lowest points, with an inspection device (IB 
or MH) located at the points marked to receive 
the sewage contributions (low point arrows).

To ensure that the segments connect correctly, 
enable the QGIS snapping tool via the menu: Pro-
ject> Snapping Options, check the Snapping op-
tion for the Acteive Layer only and select a Tole- 
rance (4 meters recommended). 

The advanced digitizing tool assists in extending 
the segments being plotted and can be enabled 
through the menu View> Panels> Advanced Di-
gitization.

To begin basic network layout: (1), Select the lay-
er of segments (2), Enable the editing mode (3) 
Enable the Add Feature tool and (4), Enable the 
advanced digitizing tools.

Enter the segment of the basic network with a 
left click, always upstream to downstream. Each 
click indicates where the collector vertex will be 
located (inspection devices - IBs and MHs), which 
in turn should coincide with the direction of the 
low point arrows. Right click to finish the layout 
of a collector.

For collectors with more than one segment, the 
following window will appear to label the collec-
tor segment name and the number of the first 
segment to be inserted. It is important not to la-
bel two collectors with the same name.

When clicking OK to confirm, be sure that the 
segments have been inserted. To display the co- 
llector and extension names, click the       button 
once to switch to plot mode,      and click again to 
return to drawing mode      .

After drawing all the collectors, check that all the 
segments are correctly connected to each other 
using the      button. This tool will select only the 
downstream most segment of the mapped net-
work. If any other segment is selected, then the 
downstream point will not match the upstream 
segment.

To make corrections in the drawing use the 
drawing editing tools of QGIS itself.      The 
tool can be used to move the vertices of the 
segments to ensure that the downstream 
point of that segment coincides with the up- 
stream point of the next segment, ensuring 
an accurate connection between them. Ano-
ther option is to erase and redraw the pro-
blem segments.
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    1.5 Linking Contributing Units to 
	 Sections

The blocks or concentrated flow units that were 
previously defined in the Blocks layer must be 
linked to the segments which will receive their 
wastewater.

To do this, select the layer of segments. Using the          
tool,     select the desired collector and: (1) Click 
on the Current Feature tab of the plugin panel; 
(2) Enter the name of the block or concentrated 
flow that feeds into the segment at the upstream 
point into the ID_UC field; (3) Click the >> button 
to save the edit and advance to the next segment.

If more than one block contributes to the same 
segment, enter the name of the two segments, 
separated by comma, as shown in the following 
image.

After verifying connectivity, insert the inspection 
devices at the vertices of the segments. This is 
done by clicking the button      and selecting, if 
there is one, the raster used to capture the terrain 
elevations.

After the basic network has been drawn and the 
inspection devices inserted, it will look as shown 
below. The segments are labeled in black and in-
spection devices in red.

To name a collector with just one segment, or to 
rename any collector, select the vector layer of 
the segments and use the Name a Patch button 
located in the SaniBID window.  Using the QGIS 
tool:     

•	 Select the first collector segment to be 
named;

•	 Select the last collector segment to be named.

If the selected segments are connected correctly, 
a window will appear with fields to fill in the name 
and number of the first segment of the collector. 
If the collector has only one segment, select the 
segment twice.

    Segments which have been drawn can be 
erased, new segments can be added and the 
vertices of existing segments can be edited at 
any time using the tool, but it is important to re-
peat the verification operations and update the 
inspection devices after making any edits in the 
layout     .
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Use the list displayed on the Flow Rate List tab to 
verify that all the blocks and concentrated flows 
have been sent to their corresponding segments. 
After selecting the tab, click Refresh to create or 
update the list.

•	 The QE column indicates the name of the 
block or concentrated flow;

•	 Columns Ip and Fp indicate the number of 
contribution units for start and end of plan, 
respectively;

•	 The TRM column displays the name of the 
segment it is contributing to. The same con-
tribution unit cannot contribute to more than 
one segment.

    1.6 Exporting QGIS network data 

To dimensioning the basic network after it has 
been drawn, the user should export the QGIS in-
formation to a .csv file with the button     and      
then load it into the spreadsheet provided with 
the plugin installer.

    1.7 RedBasica - Calculations and 
	 Dimensioning spreadsheet

NOTE: The following step is not necessary in 
regions which use a decimal point to separate 
decimal numbers from integers, such as The US, 
Canada, Mexico, the Caribbean, UK, Botswana, 
Kenya, Nigeria, China, Japan, Malaysia, Singa-
pore, Sri Lanka, and The Philippines.

For the spreadsheet to work correctly in regions 
which use a comma to separate decimal numbers 
from integers:

•	 Click on the Enable Content option that will 
be displayed at the top to enable the use of 
macros;

•	 Go to the menu File> Options> Excel Advan-
ced Tab and set the use of the decimal separa-
tors to “.” (dot) and thousands to “,” (comma).

In the START tab, follow the following steps:

•	 Using the Import Data button, select the .csv 
file with the network data exported by QGIS 
and click Open;

•	 With the Load RB button, fill in the calculation 
and dimensioning sheet with the segments of 
the network that has been drawn;

•	 Fill in the project parameters, which are in the 
sheet that can be accessed by the Parame-
ters Tab button.

The parameters used in the example are the 
spreadsheet default. To load them, use the De-
fault Parameters button. The only change will be 
the occupancy rate of 4 inhabitants / household, 
as shown below.

The values of all the cells in yellow can be 
changed as needed.

By default, flow calculations will be based on 
the number of standard contribution units re-
ported in QGIS for the projected segments. To 
use the linear sewage contribution method, 
select the “yes” option in the parameters tab.

It is important to include the initial and final 
project populations and occupancy rates for 
the calculations to be performed correctly.



Guia rápida para uso do saniBID __15

After it has been drawn, the sizing of the basic 
network is done in the RedBasica sheet, shown 
in the following illustrations. Each row represents 
a segment. Each column indicates, among other 
things, physical characteristics and flow rates of 
the system, and hydraulic flow conditions.

The sizing sheet optimizes the projected 
network, automatically searching for the 
shallowest possible depths for each segment, 
while adhering to the minimum depths and 
slopes established in the design parameters.

As in the parameter sheet, the columns in 
yellow can be edited manually.
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Columns 1 and 2, in the above image are used 
to manually force the depths of downstream and 
upstream segments. Depths entered manually  
will only be accepted by the system if they com-
ply with the minimum slope parameters of the 
segment. Depths in downstream segments will 
be adjusted automatically.

Adjustments in the pipe diameter of each seg-
ment, when necessary, must be made by the user. 
There are three options for making these adjust-
ments:

•	 Manual adjustment in column 3 - Adopted 
Diameter It is important to use a diameter 
that is on the list of diameters displayed in 
the Parameters page of spreadsheet below 
the project parameters.

•	 Semi-automatic adjustment using button 4 
- Calculate - Increasing Diameter, where the 
diameters in use will increase progressively. 
For example, if a segment of the collector has 
a diameter of 200mm, the downstream seg-
ments will have diameters equal to or larger 
than 200mm. 

•	 Semi-automatic adjustment with button 5 - 
Calculate - Suggested Diameter which uses 
the diameter required for the flow condi-
tions of each segment and may decrease in a 
downstream segment.

In the example shown, the collectors C01-004 and 
C01-005 need to have their diameters adjusted 
due to the QC1 concentrated flow that was added 
to the project. This information is available in the 
Water Level column, which displays the DN!!! 

Use button 4 - Calculate - Increasing Diameter to 
adjust the diameters of the collectors. In the ex-
ample, using button 4 will increase C01-004 and 
C01-005 to a diameter of 250 mm.

With the adopted diameters, the tractive tension 
in segments C01-004 and C01-005 at the start 
of the plan is highlighted in pink (0,75), indica- 
ting that the drag force in these segments is low-
er than the minimum (1 Pascal). To make the ne- 
cessary adjustments, increase the slope value using 
button 6 - S min ACCEPTED Collector Pipe.

Lastly, adjust the water level in the collectors to 
avoid Sewage backflow. This is done using the 7 - 
Water Level Adjustment button. This adjustment 
should be made whenever the cell on the left side 
of the button displays a non-zero value.

Whenever there is non-compliance with the 
runoff conditions, the cell will be highlighted 
in pink.

Changes in diameters, slopes, depths and 
water level influence runoff conditions. 
Whenever changes have been made to the 
spreadsheet be sure to check the columns 
for hydraulic verification and flow conditions. 
The last adjustment should always be the 
water level, when necessary.

If additional adjustments are made to the dia- 
meter or minimum slope of the segment after the 
water level adjustment, use the 8 – Clear Water 
Level Adjustmen button, and then use the 7 - 
Water Level Adjustment button again..

When no further adjustments are required, print 
the spreadsheet calculation history and export 
the dimensioning results to QGIS.
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    1.8 Printing Calculation History and 	
	 Exporting Results to QGIS

The Calculation History print sheet is generated 
by the Generate Print Sheet button, and by de-
fault is set for A3 format printing.

The Export Lines and Export Nodes buttons on 
the RedBasica spreadsheet are used to generate 
two .csv files containing the segment information 
and the sized inspection devices. These files will 
later be loaded into the project plotted in QGIS.

    1.9 Importar dados da planilha 
	 para o QGIS

When the .csv files have been generated, use the 
button       in QGIS to import the .csv file results 
for the segments and the button to       import the 
.csv file results for the inspection devices.

The information will be stored in the attribute 
table of the respective vector layers. The infor-
mation set of a segment and its upstream and 
downstream nodes can be viewed by selecting 
the desired       segment and opening the Current 
Feature tab in the SaniBID RedBasica panel.

Project information can be displayed on the QGIS 
map by switching from Drawing Mode to                 Plot 
Mode.       In Plot Mode, the black labels indicate 
segment information and the red labels indicate 
node information.

Plot Mode labels are illustrated in the figures be-
low.

To change the labels, use the tools in QGIS. To 
enable, use the menu View> Toolbar> Label. 

To move an inspection device label, select the 
layer of the nodes, enable edit mode and use the 
tool,        dragging the label to the desired loca-
tion with the left mouse button.
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    1.10 Printing a project in QGIS

Create a print layout in the manner desired, or use 
two pre-configured layouts for A0 sheet printing, 
available in SaniBID RedBasica.

To load the plugin’s print page, click on the Show 
Layout Manager button     . On the Layout Ma-
nager tab click on New From a Template. Select 
the Specific option and indicate where the print 
composer is located.

To print the sheet, click Draft Menu and go to  
Print Layout. To export the print page to an im-
age or PDF format, click Export as Image or Ex-
port as PDF.

After selecting the desired layout, click Create, 
choose a name for the print composer, select it, 
and click Show.

To display the project area on the loaded print 
composer, either click on the Map area on the 
composer or select Map 1 in the items window 
(shown on the right in the illustration below), 
then select the Item Properties tab. In the Extents 
menu use the Set to Map Canvas Extent button.

There are two pre-configured layouts in the 
Print folder that is created by the plugin, lo-
cated in the same folder as the current pro- 
ject. They are the Compositor_A0_Horizon-
tal and Compositor_A0_Vertical files.
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